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About this Manual

This User Guide includes the information you need to use the ECR 
Supervisor Viewer, one of the three main interfaces for the ECR system.

Who this Manual is for This manual is for Supervisors and System Administrators who require call 
activity information from more than one telephone station.

How this manual is 
organized

This manual is organized into four main sections.

The first section (“ECR Supervisor Viewer Interface” on page 4) provides an 
overview of the ECR Supervisor Viewer and introduces users to the main 
elements of the program, including the four main views in the program 
(Supervisor View, Station View, Statistics, and Call Finder).

The next section (“Call Record Context Functions” on page 12) provides a 
description of all the things you can do when you select a call record. This 
includes playing the record, emailing it, adding a comment to it, protecting 
it, locking it, and much more.

The third section (“Tools Menu Functions” on page 17) provides a 
description of various functions you can perform using the items under the 
Tools menu. This includes maintaining recording hardware, shutting down 
the recording system, exporting data to Excel, and changing the user 
password.

The final section (“Options” on page 21) describes the  various settings of 
the program from the Tools>Options menu. 

Related 
Documentation and 
Software

• ECR Installation and Setup Guide
• ECR Station Viewer User Guide
• ECR Configuration Tool User Guide
• Hardware Quick-Start Guides

Support Information ECR includes one year of support from the date of purchase. Support 
agreements are available to extend this support period. Please contact Algo 
for information and pricing.
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ECR Supervisor Viewer Interface
The ECR Supervisor Interface provides full access to the ECR database and 
real-time status functionality. Features include call record playback, real-
time audio streaming, and system-wide event monitoring. ECR Supervisor is 
part of both the Client and Server installations and is intended for 
managers and ECR supervisors who wish to monitor and review recorded 
conversations from multiple users and stations.

Getting Familiar

The ECR Supervisor Interface is made up of four main views:

• Supervisor View (default startup view)
• Station View
• Statistics
• Call Finder

Common Elements There are several common elements to the View windows in the ECR  
Supervisor Interface. These include:

• The Drop-Down Menu at the top of the screen
• Toolbar
• View Tabs
• Call Playback Panel

Drop-Down Menu

The drop-down menu provides a consistent navigation system throughout 
the Supervisor Interface, available from all  four main views.

Toolbar

The Toolbar contains icons for quick feature selection. For detailed 
information on these icons, please refer to  “Call Record Context 
Functions” on page 12. The Toolbar icons are greyed out when a call 
record is not actively selected.

View Tabs
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The View Tabs make it easy to switch between Views. Simply click on the 
tabs to change to the selected view.

Player Panel

The Player Panel is for playing back selected call records. For more 
information on this panel, please refer to  “Player Panel” on page 10.

Supervisor View

The Supervisor View provides an abundance of real-time information 
including Set Display, Telephone Status and telephone Operator Username 
for each configured station. Double click on any row to select that station 
and open it in the Station View where call records can be accessed.

Right click on a Station to bring up the 
Supervisory feature commands: View Station, 
Enable Streaming, Set Station to Manual 
Record, and Set All Stations to Automatic 
record.

Select Enable Streaming to activate on demand audio. See Section 3.3 for 
details on how to listen to real-time streaming call audio. Note: Streaming 
is only available when recording in WMA mode.

Display column 
definitions

Station The name of the Station as set in the ECR Configuration Tool.

User The name of the Operator logged into the Station appears here along with 
the name of the computer they are logged in from.
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Phone Status The current phone status, i.e. Idle or Call in Progress.

Set Display This shows the current information from the LCD on the telephone.

Mode Displays the Station’s current recording mode: Automatic or Manual.

Call Record File For active calls, displays the name of the call record file currently being 
created.

Login Time If a user has logged into the station, this column provides the date and time 
of the login.

AuxBox Status Confirms the attached recording device is connected to the system and 
functioning correctly.

STNID The unique ID number assigned to this station internally by the software.

Stream Displays streaming function status. Displays Enabled when streaming is 
activated and available, display is blank when not enabled, or Not 
Available when streaming can not be activated (i.e. recording in WAV 
mode).

Station View

 The Station View is the primary interface to play back and manage 
recorded conversations, and to listen to streaming real-time conversations 
for the station.

Drop-Down Menu

Toolbar

View Tabs

Telephone Status
Panel

Call History List

Player Panel

Audio Stream Player
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Telephone Status 
Panel

Along with Set Display and real-time Call Duration information, an 
animated graphic in the Telephone Status Panel provides a visual 
representation of telephone status. While on a call users can enter 
comments about the call in the Comments field. In addition, if streaming 
has been enabled for the station, the streaming player will be displayed 
which allows supervisors to listen in on real-time conversations for the 
station.

Call History List The Call History List contains a listing of recent calls for the Station. To 
operate on a call record, left click on the desired call in the list  and use the 
Toolbar to execute the desired operation. Alternatively, right-clicking on a 
call record pops up a handy quick menu including all the functions of the 
Toolbar in addition to items in the File and Edit menus.

To play back a call, left click on the desired call then use the playback 
controls at the bottom of the screen. Along with basic play, pause and stop 
controls, playback time and volume can be changed by use of the slider 
controls (refer to “Tools Menu Functions” on page 17).

The Call History List list displays all of the relevant information related to 
each call record. This includes the start time, duration, set display, user 
entered comments, type of call, protection status, call record filename, and 
the file format (wma or wav).

• Clicking on each column heading automatically sorts the call records. 
You can use this feature to easily sort or locate calls.

• Each column is resizable. Just click on the border between two column 
headings and drag to the desired size.

• By selecting a call record and right-clicking, you can play or email the 
record, add or edit comments, edit set display text, delete the record, 
protect the record from automatic deletion (or unprotect it), save the 
record as an external file, or copy the record to another directory.

• Because ECR call records are Windows files, they can be selected, cop-
ied, or dragged-and-dropped from the Call History List to different 
folders, back-up media, emails, or your desktop.

Call History List 
Column Descriptions

Start Time Time and date of the start of the call.

Duration The duration of the recorded conversation with one second resolution.

Set Display Contains outbound dialled number and inbound Caller ID. Other details 
may be captured depending on telephone technology and the model of the 
attached recorder device.

Comments During a call, comments can be added in real-time via the comments filed 
in the Telephone Status Panel. After the call is completed, comments can be 
added to the call record by using the Comments command in the Toolbar 
or by right-clicking a call record and choosing Comments.
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Type Type of call: Outgoing, Incoming, or Missed Call. 
Note: The type of call is based on the ring cadence detected at the 
telephone. For systems where the telephone does not ring, or only provides 
a single alerting tone on an inbound call, some calls may be incorrectly 
flagged as “outbound”.

User The name of the User for which the call was recorded.

Protect The status of the Protect flag. If protected, the record will indicate ‘YES’.

Locked By Indicates whether the call record is locked and, if so, by what user.

Call Record File The file name of the call record file.

Format The type of call record file. The default is .wma (Windows Media file).

Call Finder

Call Finder is a powerful search utility that allows for easy retrieval of calls 
in the database. Call Finder displays all calls in the database that meet the 
specified search criteria. All matches will be displayed - there is no limit to 
the number of records that can be listed.

For example, if no criteria are selected, executing the search will display all 
call records in the database at the time that the search is started (this differs 
from the Station View which normally lists only a limited number of the most 
recent calls, but updates as new calls are created).

A number of search parameters are accepted to perform a search as 
defined below:

Searching Station Allows Station specific or global searches. Stations not included on the 
User’s allowed Station list will not be accessible from the Call Finder.

Date The calls searched will be limited to the interval between the dates specified 
in the Calls From and Calls To fields. Default value interval is all calls 
recorded since installation
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Comments Allows search based on user-entered comments. Any portion of the call 
record comment matching the search parameter will return a positive 
match.

Set display Allows search based on set display information (Caller ID and dialled 
number).

For example, searching by area code can quickly return all calls from a 
particular region.

Searching a complete phone number will return all call records with that 
number appearing in inbound (Caller ID), or outbound (dialled on 
telephone)

Length of call Searches can be based on call durations. Common uses are to screen out 
short calls or search for abnormally long calls

User Allows limiting of search to all made by a specific User. Note that the User 
must be logged in as an Operator while taking calls to have User 
information appended to the record

Call type Allows limiting of search to Incoming, Outgoing, or Missed Calls. 

Statistics

ECR keeps track of telephone usage and can provide interesting and useful 
statistical information. Depending on what privileges a user is granted, 
data can be calculated based on all Stations, specific Stations, or the 
current station. Data can also be limited based on a range of dates.

To access this information:

1. Click the Statistics tab, or select View>Call Statistics.
2. Select the desired Station setting.
3. Choose the desired From and To dates.
4. Click the Generate statistics report button.

Available statistical information includes:
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• Number of telephone calls made outbound
• Number of telephone call received
• Number of missed telephone calls
• Number of imported calls
• Longest, shortest, and oldest call, and
• Average call duration

Data appearing on screen can be exported to 
Microsoft Excel® using the Export to Excel feature 
found in the Tools menu. 

Player Panel

Use the Player Panel to control and monitor the playback of a selected call 
record. The Player Panel includes the following information and controls:

Playback File Provides the name of the currently selected call record file.

Playback Progress 
Slider

Provides a visual timeline indication of the playback progress and also 
allows you to quickly jump ahead or back to sections of the call record file.  
To use the slider, left-click click the slider, hold the mouse button down, then 
drag the slider to the portion of the call record you want to listen to.  
Alternatively, you can left-click anywhere on the timeline to make the 
playback jump forward or backward.

Playback Progress 
Summary

Provides information of how long the current call record file is and how far 
along the the playback has progressed (in minutes and seconds).

Playback Buttons Use the basic Play, Pause, and Stop buttons to control the playback of the 
call record file.

Volume Slider Drag the volume slider to control the playback volume of the call record 
file. If you are unable to generate enough volume, try adjusting your PC 
audio settings or turn up the volume controls on your speakers.

Play Speed
SliderVolume Slider

Play
Pause
Stop

Playback File

Playback
Progress
Slider

Playback Progress 
Summary

Playback 
Buttons



ECR Supervisor Viewer Interface: Player Panel

www.algosolutions.com 11

Play Speed Slider This control allows you adjust the speed of the playback of the call record 
file with minimal effect on the clarity of the content. A slow speed is useful if 
you have to type out a written record of a file and want to ensure the 
conversation is slow enough for you to keep up. A faster speed allows you 
to quickly scan through a file to find a particular piece of information.   
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Call Record Context Functions
Call Record context functions are available for use when 
a call record is highlighted in either the Station View or 
Call Finder. The complete list of call record functions is 
available by right-clicking on a call record. A subset of 
these functions is also available from the Toolbar. In 
addition, when a call record is highlighted, the Play 
function can be accessed from the Player Panel at the 
bottom of the screen.

Note that unless a call record is highlighted, all toolbar 
icons will be greyed out.

Note also that not all Call Record context functions may be available to all 
users. This is because the privilege to use these functions is set by the ECR 
System Administrator. Contact your system administrator if you do not have 
the priveleges to use any of the following functions.

Play

Plays back a call record file. For full playback control of call records, refer 
to  “Player Panel” on page 10.

Email

Call records may be easily emailed as attachments by simply highlighting 
one or more call records and choosing the Email function. A new email 
composition window will open (using your default email software) with the 
call record(s) pre-attached. In addition, the call detail and comments are 
inserted into the text body. 

Note: In order to use this feature, a MAPI compliant email program must 
be installed. Microsoft® Outlook® and Outlook Express® are configured 
correctly by default, however Netscape® requires the MAPI option to be 
selected in the email program setup. Email signature attachment is only 
supported with Microsoft Outlook.

Standard Windows controls work in the Call List window to select multiple 
call records - for example, holding the CTRL key while clicking the selected 
call records you wish to email.
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ECR will also include an “Algo Recorded” line of text in the email message. 
This text line may be deleted manually and set to not be displayed by 
unchecking the Display Recorded message checkbox in 
Tools>Options>User Display Settings.

Any of the automatically inserted text may, of course, be edited or deleted if 
you do not wish to share this information with your recipient. Keep in mind 
that this information is also embedded in the audio file (e.g. comment text), 
but will not be retrieved by Windows Media Player.

Comments

Adding comments to a call record not only helps summarize the contents of 
a call but also makes search and retrieval much easier at a later date.

Anytime while recording a call, comments (up to 200 characters) can be 
typed into the Comments bar in the Current Call section of the Station 
View.

Once a call is saved, 
comments may be added or 
edited by selecting the 
Comments function. You can 
then add or edit text in the 
Comment text box.

Comments are embedded into call records, just like Caller ID and other 
data, to be retrieved by Client Call Recorder.

Quick Find

The Quick Find function 
allows you to quickly search 
all the fields in the displayed 
call list in the current view 
window (can be Station View 
or Call Finder Views). The 
function highlights any call records in the current view window, from ANY 
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field, that match the text entered in the Quick Find search box. Note that for 
full search capabilities on all calls in the local ECR database, use the Call 
Finder function.

Delete

The Delete function allows you to delete one or more call records that have 
been selected in the Call List window. Note that the delete key on the 
keyboard will perform the same function. Note also that the Delete function 
will not delete protected records. To delete a protected record, first 
unprotect the record, then delete it.

Protect

Allows you to protect a call record so that it cannot be deleted (manually or 
automatically) within the ECR system. This feature ensures that a call record 
will remain in the ECR database even if the Automatic Delete function is set.

In addition, protected call records will not be counted as part of the 
Number of Calls limit set for the Automatic Delete function (if used). For 
example, if you have set the Number of Calls limit to 20 calls and have 
protected two calls, you will store the two protected calls plus the 20 most 
recent calls.

To protect a call record, select the record then choose the Protect function. 
To manually delete a protected call record, first unprotect it, then delete it.

Unprotect

Disables the Protect feature.

Lock

Prevents the call record from being played, emailed or viewed by other 
Operators.
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Unlock

Disables the Lock feature.

Edit Set Display

Allows you to edit the 
automatically-generated text in a 
call record’s set display field, up 
to a maximum of 200 
characters.

Save As

Allows you to save a call record 
under a different name or to a 
different location on your 
computer or storage media.

Copy

Allows you to copy selected call 
records to a different directory 
on your computer or storage 
media. To use this function, first 
select the call records of interest 
from the Station View or Call 
Finder views, choose Copy, then 
select the target folder to copy 
to.
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Select All

Selects all the call records in the currently displayed call list.  
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Tools Menu Functions
System wide options and control is available from 
the Tools drop down menu. Each feature available 
from this menu item is detailed below.

Hardware Maintenance

If there is recording hardware attached to your PC, the Hardware 
Maintenance interface provides access to these devices for programming 
firmware and Serial Numbers. 

Note that before accessing these 
devices, the recording system will 
need to be temporarily shut down.

All recording devices attached to 
the PC will be listed in the 
Maintenance window. The Serial Number, Firmware Version, and Type of 
Algo Recorder are listed.

Recorders can be disconnected or 
connected to the PC with the 
maintenance window open. Click 
the <Refresh List> button to 
update the listing.

To program a recorder, left click on 
a listed recorder. The lights on the 
front of the selected recorder will 
flash when selected. Then click on 
the buttons at the bottom of the window to perform the desired operation.

To upgrade the Firmware of all attached 4102 AuxBoxes and 4102R 
AuxCards simultaneously, right click on any listed recorder and select 
<Upgrade all 4102 AuxBoxes>.



Tools Menu Functions: Recording System Commands

ECR Supervisor Viewer User Guide 18

Recording System Commands

Access to global and local recording system 
commands are provided through this 
interface.

The upper controls provide control over the 
recorders attached to the local PC, be it Server 
or Client. When this function is accessed from 
the ECR Server PC, the upper controls are 
labeled “ECR Server System”. When this 
function is accessed from a Client PC, the 
upper controls are labeled “Client System”.

The Client and Server Recording commands 
will start up or shutdown all recorders globally 
for the entire ECR system. Use these 
commands with caution as critical call recording can be disrupted.

Note these controls only affect the recording system programs. Open 
graphical interfaces (such as the Station View or Call Finder view) will not 
be affected by these controls.

Diagnostics

This function is only available if granted Diagnostic View access from your 
ECR Administrator (via the ECR Configuration Tool). If this privilege is 
granted, a new Diagnostics tab view will be displayed and a Diagnostics 
menu item will be added under the Tools menu.

The Diagnostics panel provides all Station, User, and Computer properties 
within ECR in a single interface. This panel is primarily used for 
troubleshooting.

Export Data to Excel

This function will export all data displayed in the view window to Microsoft 
Excel.  This function is available from all enabled views of the ECR 
Supervisor Viewer (Supervisor View, Station View, Statistics, Call Finder, and 
Diagnostics View).
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Change password

Allows the currently logged in User 
a quick means to change their 
password.

License Management

A number of helpful panels are provided to manage ECR recorder licenses.

License Info Lists all current license keys entered into 
the ECR system.

Station Map Lists each Station and which license key 
that Station's active license is drawn 
from.

Add License Key Station license keys can be added to the 
ECR after initial installation.
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Reassign Licenses Licenses can be moved from one 
recorder to another when free licenses 
aren't available or when transitioning 
from Trial licenses to permanent licenses.
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Options

User Display Settings

This tab includes options for controlling 
how many recent calls will be displayed 
in the Station View’s Call History List of 
call records.  In addition, this tab allows 
you to set the format of the date display 
of call records and to control the 
automatically-inserted text that goes into 
generated emails.

The settings in this tab apply to the 
Station View window for the user’s ECR 
Station Viewer as well as for the ECR 
Supervisor (if enabled for that user).

The display of calls can be limited by:

• Number of calls (up to 999)
• Period of time (up to 30 days for the ‘Days’ drop-down box, and up to 

24 hours for the ‘Hours’ drop-down box)

Email Settings • The Enable Signature Display setting allows you to automatically 
include Email signature text (from your email client) into any emails sent 
from ECR.

• Unchecking the default “Algo Recorded” message setting allows you to 
remove the automatically inserted message text (e.g. “This call was 
recorded using an Algo 4105 Analog Auxbox with the Enterprise Call 
Recorder V2.2 software”) displayed in the emails.
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Station Settings

The settings in the Station Settings tab 
are available for viewing but are NOT 
editable in the ECR Supervisor Viewer. 
The settings are thus greyed out but still 
indicate the current settings for the 
station. To make changes to Station 
settings, please use the ECR 
Configuration Tool. For reference, the 
Station Settings  tab includes the 
following information:

• the status of the Hidden Mode
• whether Missed Call records will be 

generated and, if so, the time delay 
associated with generating those records

• the audio recording format and associated file size and compression 
for the call record files

Hidden Mode This option indicates whether the Windows system tray icon will be 
displayed for the station.

Record Missed Calls   This setting indicates whether the ECR system has been set to log missed 
calls or not for the station. A log of missed calls can be very useful to gauge 
telephone activity.

When enabled, ECR will generate a missed call record whenever the 
telephone rings but is not picked up. This record stores the time and date of 
the call as well as Caller ID information.

Missed Call Delay This option defines the interval ECR waits at the end of ringing before a 
missed call record is generated. The adjustment compensates for ring 
cadence variations and delays between ring and the telephone in-use 
events. Adjust the detection delay if missed calls are generating multiple 
records. Note that while the time delay can be set for up to 30 seconds, a 
typical setting will be 4 to 5 seconds.

Recording Format ECR allows calls to be stored in 
either WAV format (raw 8kHz, 16bit 
data) or compressed Windows 
Media Audio® (WMA). The WMA 

Note that logging missed calls should be 
disabled when a single inbound call rings 
multiple telephones, as in hunt groups, to avoid 
large scale generation of missed call records
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data rate is selectable from pull down menu. WAV recording provides the 
best recording quality, but consumes storage space very quickly: 29 MB per 
hour.

The WMA recording compression can be set to either 3MB or 5MB per 
hour. The 5MB per hour setting offers improved audio quality at the 
expense of increased storage usage.  

Filter Calls

 The settings in the Filter Calls are 
available for viewing but are NOT editable 
in the ECR Supervisor Viewer. The settings 
are thus greyed out but still indicate the 
current Filter Calls settings for the station. 
To make changes to Filter Calls settings, 
please use the ECR Configuration Tool. 
For reference, the settings in the Filter Calls 
tab can be used to avoid automatic 
recording of routine calls such as personal 
calls from a home telephone. Note that 
users can override this function and 
manually save files, if desired.

Filter by patterns Up to ten different phone numbers (or alphanumeric strings or 'patterns') 
can be entered into the Filter by patterns list that will be used to prevent 
calls from being automatically saved.

This function works by searching for the pattern in the set display. Thus, you 
can enter partial text or numbers instead of exact phone numbers or 
names. If there is a match, the call record is not saved.

Note that ECR will look for any match, so if you enter just "9" in the Filter 
Calls list, any number dialed that includes a 9 will not be recorded. Make 
sure you test your Filter Calls string to ensure you get the results you intend.
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Recording

The settings in the Recording tab (with 
the exception of the Phone HotKeys) 
are available for viewing but are NOT 
editable in the ECR Supervisor Viewer. 
The settings are thus greyed out but 
still indicate the current Recording 
settings for the station. To make 
changes to Recording settings, please 
use the ECR Configuration Tool. For 
reference, the Recording Settings  tab 
includes the following information:

• whether calls will be saved auto-
matically - or manually by the user

• what phone or keyboard keys 
users can use to trigger the manual saving of call records or the setting 
of the call record protect flag

• what key can be used to toggle recording on or off

Save Mode Sets the Station Save Mode to either Automatic Record or Manual Record.

In Automatic Record mode, ALL station calls (including inbound, outbound, 
and missed calls) are automatically recorded and saved to the ECR 
database with the exception of:

• calls where the set display matches any of the patterns in the Filter Calls 
list, if configured 

• Missed calls if the Record Missed Calls function is turned off .

In Manual Save mode, only those calls a user manually selects are saved 
into the ECR database.

Phone HotKeys ECR supports two types of on-demand recording: Entire save (Save Key); 
and toggle record (Record Key).

Save Key Press the Save Key to store an entire call at any point during the 
conversation, or after the call has ended. ECR caches the last conversation 
to allow the call to be saved. A new call deletes the cached previous call.

Note: This feature is useful in Manual Mode as it allows the unsaved last 
call to be saved.

Record Key The Record Key allows a portion of a conversation to be stored as a call 
record. The first press of the Record Key begins audio recording from that 
point. A second press will stop recording and generate a call record 
containing the enclosed portion of conversation.   
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AuxBox Configuration

The settings in the AuxBox Configuration 
tab are available for viewing but are NOT 
editable in the ECR Supervisor Viewer. 
The settings are thus greyed out but still 
indicate the current AuxBox Configuration 
settings for the station. To make changes 
to AuxBox settings, please use the ECR 
Configuration Tool. For reference, the 
AuxBox Configuration Settings tab shows 
the various relay modes for a Station’s 
AuxBox or AuxCard hardware, audio level 
settings, audio recording modes, and 
speech decoding modes.

Select AuxBox Relay 
Modes

The relay output(s) on the Station recorder can be configured to activate on 
different telephone states.

Depending on the AuxBox recorder attached, some selections may be 
disabled.

'All Modes' activates the relay on all event triggers with the exception of 
'Save Activated'. Fast flash for Ring, on solid when In-Use, slow flash when 
a message is waiting.

'Save Activated' mode call is triggered when a call is set to be saved - either 
because the station is operating in automatic save mode or because 
manual recording has been triggered.

Select Audio Level The digital and analog audio level is adjustable between two levels: Low 
and High. The low level provides more dynamic range for improved quality. 
The high maximizes audio gain to correct for low source audio levels.

Audio Recording Audio output can be limited to receive audio only for applications that do 
not want the near side caller recorded. Radio call-in shows and radio 
dispatching are common uses for this feature.

Select Speech 
Decoding

Audio on Nortel digital TDM telephones is encoded differently depending 
on region. For North America, this setting should be uLaw. In Europe, the 
setting should be aLaw.

Improper configuration of this setting will result in recordings that are 
unintelligible and garbled.
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Call Record Storage

 The settings in the Call Record Storage tab are available for viewing but 
are NOT editable in the ECR Supervisor Viewer. The settings are thus 
greyed out but still indicate the current Call Record Storage settings for the 
station. To make changes to Call Record Storage settings, please use the 
ECR Configuration Tool. For reference, the Call Record Storage tab 
includes several options to help keep storage requirements low. This 
includes the option to automatically delete call record files based on how 
old they are (number of days), how many there are, or how much hard disk 
space (in MB) they take up.

Limit Call Storage By The size of the call record database can be limited in three ways:

1. By call record date
2. Number of call records in the database
3. By disk space used

When limiting by number of days, call records older then the defined limit 
are automatically deleted from the call database.

Cautions When limiting by number of calls or disk space, the oldest calls are deleted 
automatically once the defined limit is reached. If you set the system to 
automatically delete records based on days, number of calls, or storage 
space, keep in mind that there is a risk that you could occasionally delete 
wanted files. Therefore, it is important to set these conditions properly. 
Consider the following problematic cases:

Limiting by Number of
Calls

If someone calls the station fifty times one day while the user is out, it may 
prematurely push important records into the recycle bin.

Limiting by Number of
Days

If the user at the station has a schedule disruption, like an extended 
business trip, some of the call records they may have been expecting to 
review upon return may have already been deleted.

Limiting by Storage MB If a user at the station has one or more lengthy conversations that use up a 
lot of memory, it may prematurely push important records into the recycle 
bin. 
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